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ABSTRACT: This work aims at identifying and mapping using Earth Observation (EO) and Geographic Information Systems
(GIS), the water-erosion risk areas. The RUSLE (Revised Universal Soil Loss Equation) model, which can be used to estimate
the water-erosion risk of soil, was applied to the productive Sanguéré watershed of North Cameroon. He includes factors
such as: rainfall aggressiveness, soil erodibility, slope length and steepness, type of land use (cover and management
practice) and support or conservation practice. Two land use maps were produced, one based on field observations and the
other on the calculation of MSAVI2 (Second Modified Soil-Adjusted Vegetation Index) on Landsat 8 image of April 4, 2013, to
judge the quality and the accuracy of each type of the information for the model. The analysis, the combination of data
(satellite images, existing thematic maps, field observations) and the application of the model were all carried out using GIS;
which enabled the production of synthetic maps showing the degree of sensitivity to water erosion. The erosion risk maps
derived shows five degrees of vulnerability in this area: none to very low, low, moderate, high and serious. If we consider
that the class of moderate erosion risk is high, our watershed would present about 62 Km² area exposed to water erosion, or
approximately 75% of its total area. The Sanguéré watershed being representative of the region in terms of the geology,
pedology and hydrology; the methodology presented in this study can be applied generally to the entire North Region of
Cameroon where the risk of erosion is a threat to the rural agricultural sector.

KEYWORDS: Water erosion, watershed, EO, GIS, Cartography.

RESUME: Le présent travail a pour objectif d’appliquer une méthode utilisant les images d’Observation de la Terre (OT) et le
Système d'Information Géographique (SIG) pour identifier et cartographier les zones à risque d’érosion hydrique des sols. Le
modèle RUSLE (Revised Universal Soil Loss Equation), avec lequel on peut estimer les risques d’érosion hydrique des sols, a
été appliqué au bassin versant productif de Sanguéré au Nord Cameroun. Il compte parmi ses facteurs : l’agressivité des
précipitations, l’érodibilité des sols, l'inclinaison et la longueur des versants, le type d’occupation des sols et les pratiques
antiérosives. Deux cartes d’occupation des sols ont été réalisées, l’une à partir des observations de terrain et l’autre à partir
du calcul du MSAVI2 (Second Modified Soil-Adjusted Vegetation Index) sur l’image Landsat 8 du 04 avril 2013, pour juger la
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qualité et la précision de chaque type de ces informations dans le modèle. L'analyse, la combinaison des données (images
satellitaires, cartes thématiques existantes, observations de terrain) et l’application du modèle ont été opérées dans un SIG.
Ce dernier a permis de produire des cartes synthétiques de répartition des degrés de sensibilité à l’érosion hydrique. Les
cartes de risque d’érosion qui en sont dérivées montrent cinq degrés de vulnérabilité dans notre site : nul à très faible, faible,
modéré, élevé et grave. Si l’on considère qu’à partir de la classe d’érosion modérée le risque est important, notre bassin
présenterait une superficie d’environ 62 Km² exposée à l’érosion hydrique, soit environ 75 % de sa superficie totale. Le bassin
de Sanguéré étant représentatif de la région sur les plans géologique, pédologique et hydrologique, la méthodologie
présentée dans cette étude peut être généralisée à toute la région du Nord Cameroun où les risques d’érosion constituent
une menace pour le secteur agricole à majorité rural.

MOTS-CLEFS: Erosion hydrique, bassin versant, OT, SIG, Cartographie.

1 INTRODUCTION

Au Cameroun, les milieux ruraux sont très exposés aux problèmes environnementaux tels que les inondations, la
dégradation des terres par l’érosion sous toutes ses formes (dont l’érosion hydrique…), le surpâturage, les criquets-pèlerins,
la sècheresse des terres, la désertification, pour ne citer que ceux là, et qui affectent considérablement le secteur agricole
rural. L’identification et la caractérisation de ces obstacles naturels au développement dans le monde rural à des fins de
contrôle et de suivi, ainsi que la vulgarisation des résultats obtenus pour une prise de décision adéquate et une bonne
orientation des actions à mener sont des réponses qui font partie de notre contribution à la perspective de développement
de ce secteur.

L'érosion hydrique, objet de notre attention, est un phénomène de dégradation qualitative et quantitative des sols qui
affecte de larges surfaces, en particulier dans les zones intertropicales et méditerranéennes [2].

Principal responsable de la dégradation des terres cultivées, ce phénomène entraine des pertes en terres considérables
sur les sols dénudés et les défriches récentes [1], sur les pentes, à cause de la nature torrentielle des pluies, de la forte
vulnérabilité des terrains (roches tendres, sols fragiles, pentes fortes et dégradation du couvert végétal) et de l’impact
défavorable des activités humaines (déforestation, incendies, mauvaise conduite des travaux agricoles, urbanisme
chaotique...) [2]. C’est la partie superficielle des sols, la plus importante pour les cultures, où sont concentrées la matière
organique et la majeure partie des éléments minéraux assimilables par les plantes, qui disparaît en priorité [1], et c’est
l’agriculteur qui, de façon spectaculaire, subit les premiers effets négatifs de ce phénomène.

Les études qui existent sur l’érosion hydrique et la dégradation des terres au Cameroun [20], [25] - [21] dans leur grande
majorité n’intègrent pas ou très peu les méthodes d’OT et les techniques d’analyses spatiales par un SIG pour la connaissance
et la cartographie de ces phénomènes. Ces outils qui sont pourtant de nos jours de plus en plus utilisés pour l’étude et la
connaissance des phénomènes de surface, permettent également le développement d’une approche méthodologique pour
le choix des données et des traitements nécessaires à effectuer pour étendre la méthode sur d’autres zones présentant les
mêmes problèmes.

Nous nous proposons donc d’exploiter les possibilités qu’offrent l’OT et les techniques d’analyses spatiales par
l’intégration des différentes couches d’informations dans un SIG et d’appliquer la version révisée de l’équation universelle
des pertes en sol (Revised Universal Soil Loss Equation, RUSLE) de [16] dans un bassin versant productif exposé à ce
phénomène et par conséquent à une dégradation de ses terres : le bassin versant de Sanguéré, situé au Nord du Cameroun.

Le but de notre étude est d’utiliser l'imagerie satellitale et des cartes thématiques existantes comme source de données
d'entrée, et de coupler celles-ci avec des observations sur le terrain dans un SIG pour : identifier et cartographier les zones à
risques d’érosion hydrique dans le bassin versant de Sanguéré; vulgariser les résultats pour une prise de décision adéquate,
et une bonne orientation des actions à mener dans la lutte contre ce phénomène de surface.

2 ENVIRONNEMENT DU SECTEUR D’ETUDE : PREDISPOSITIONS A L’EROSION HYDRIQUE

Situé à environ 15 Km au Sud de la ville de Garoua (chef lieu du département de la Bénoué, Région du Nord Cameroun),
de part et d’autre de la route Garoua-Ngaoundéré, entre les coordonnées 9°06' - 9°15' N et 13°26' - 13°31' E (figure 1), le
bassin versant du Mayo Dadi (autrefois Mayo Ain Dala) dont la superficie est d’environ 82 km2 constitue l'ensemble des
bassins versants de Sanguéré. Il appartient au grand bassin hydrographique de la Bénoué, important affluent du Niger.
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Allongé dans le sens nord-sud, le bassin du Mayo Dadi est limité à l’Est et au Sud par une série de collines de grès crétacé,
alors que la limite Nord et Ouest située dans une zone sans relief notable est assez imprécise [5].

Il est situé dans la zone de climat tropical de type soudanien caractérisé par l’alternance d’une saison sèche (novembre à
mars) et d’une saison humide (de mai à septembre), les mois d’octobre et avril faisant la transition. La pluviométrie moyenne
annuelle est de 1027,2 mm, avec le maximum des pluies en août de l’ordre de 238,7 mm. Les mois de novembre, décembre,
janvier, février, mars et avril n’enregistrent généralement pas de précipitations. La température moyenne annuelle dans la
région est de l’ordre de 28,3°C. Avril est le mois le plus chaud avec des températures atteignant 40°C.

Le paysage, mollement ondulé, est une succession de versants à faible pente séparés par des vallons très évasés (figure
2). De cette pénéplaine émergent quelques massifs résiduels (Inselbergs) à sommet tabulaire, très caractéristiques des
formations gréseuses [4] : les "grès de Garoua".

Le secteur d’étude qui appartient entièrement au bassin versant de la Bénoué affluent du Niger, est drainé par le Mayo
Dadi, et ses tributaires, qui prend sa source dans les massifs gréseux situé à l’Est et au Sud et se jette à l’Ouest dans le Mayo
Douka, l’un des affluents de la Bénoué.

Le système de sol dominant est constitué de sols ferrugineux tropicaux, sur les "grès de Garoua", différenciés en un
compartiment ferrugineux (80%) en position haute, un compartiment lessivé (15%) en position intermédiaire et un
compartiment hydromorphe (5%) localisé dans les bas-fonds (figure 3). Ces sols qui contiennent essentiellement du quartz et
de la kaolinite, un peu de goethite sont sableux, perméables, très pauvres en matières organiques et généralement très
sensibles à l'érosion hydrique, accentuée par la disparition du couvert végétal [4]. Ils reposent sur les "grès de Garoua" du
crétacé supérieur, séries sédimentaire à matériaux quartzeux dominant.

La végétation dans le bassin versant est constituée d’une savane arbustive soudanienne fortement dégradée avec
quelques grands arbres, reliques de la savane boisée originelle, et d’une prairie marécageuse [4].

Le département de la Bénoué avec sa population de 851955 habitants, 519409 habitants en zone rurale contre 332546 en
zone urbaine (3ème recensement général de la population du Cameroun, 2010), est de loin le département le plus peuplé de
la Région du Nord, soit 50,47% de la population totale. Cette population essentiellement rurale (70%) et hétéroclite pratique
principalement à près de 90 % l’agriculture et l’élevage. Ces pratiques culturales intenses et la vaine pâture se sont révélées
être des facteurs de dégradation de la matière  organique et de l’érosion des sols.

3 DONNÉES UTILISÉES ET MÉTHODOLOGIE APPLIQUÉE

La méthodologie adoptée pour cette étude repose sur l’exploitation des données multisources (satellitaires,
pédologiques, météorologiques et des observations faites sur le terrain), multiéchelles, aux formats hétérogènes. Toutes ces
données sont intégrées et analysées dans un environnement SIG pour la cartographie des zones exposées à l’érosion
hydrique dans notre secteur d’étude.

3.1 DONNÉES UTILISÉES

Les données suivantes ont été utilisées dans notre étude :

 Une image Shuttle Radar Topography Mission (SRTM) de résolution 90 m ; de coordonnées 05° - 10°N, et 10° - 15°E,
obtenue sur le site : http://srtm.csi.cgiar.org/SELECTION/inputCoord.asp.

 Une scène multispectrale Landsat-8/LDCM (Landsat Data Continuity Mission) OLI/TIRS (Operational Land Imager/ Thermal
Infrared Sensor) de Path_185/Row_054, acquise le 12 avril 2013 (LC81850542013102LGN01). Cette image est fournie par
le site http://earthexplorer.usgs.gov/, au format Geotif.

 Des observations de terrain, obtenues après une descente sur le site en avril 2013.
 Une carte pédologique détaillée, du bassin versant de Sanguéré, dressée par [4].
 Des données pluviométriques fournies par le Service d’Appui Technique (SAT) de la Société de Développement du Coton

(SODECOTON), un réseau privé, complétées par celles de la station météorologique de Garoua dans la Bénoué, repérée
par les coordonnées 09°20’N et 13°23’E, 242 m. Elles s’étalent sur une période de 14 ans (1998-2011) et couvrent notre
zone d’intérêt.
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3.2 MÉTHODOLOGIE APPLIQUÉE

Plusieurs méthodes intégrant les facteurs d’érosion ont été développées. Les modèles actuels de quantification des
pertes en sol par érosion en nappe sont généralement basés sur l’équation universelle de pertes en sol USLE et sa version
révisée RUSLE [16], régulièrement complétée et adaptée selon le milieu bioclimatique, qui peut parfois être totalement
différent de celui à l’intérieur duquel l’équation a été conçue.

Il est question de choisir pour notre étude un modèle qui permette, grâce aux SIG, la spatialisation de l’érosion hydrique à
l’échelle des bassins versants et non plus des parcelles. Il s’agit ici d’avoir une connaissance de la répartition spatiale de
l’érosion sur notre bassin versant.

Notre choix pour cette étude s’est donc porté sur l'équation universelle des pertes en sol révisée (RUSLE) la version
améliorée provisoire de l'USLE, pour la détermination des divers facteurs de l’érosion hydrique.

Le RUSLE reprend la même équation empirique que l'USLE et s’utilise à l’échelle du champ agricole ou du petit bassin
versant [9]. Il a été informatisé ce qui facilite sa manipulation et sa diffusion comme outil de prédiction des pertes en sol. La
convivialité de l’USLE/RUSLE fait qu’il demeure une approche de modélisation très populaire et pratique [9].

Cette équation s’écrit comme suit :

A = R. K. LS. C. P   (1)

Où :

A (t/ha/an), est le taux annuel de perte en sol ;

R (MJ/mm / ha. H. an), est le facteur de l’érosivité des pluies ; il correspond à la moyenne annuelle des sommes des
produits de l’énergie cinétique de la pluie par son intensité en 30 mn consécutives ;

K (t. H / MJ. mm),  est l’érodibilité des sols ; il est fonction de la texture du sol, du taux d’humus, de la structure de la
couche superficielle du sol ainsi que de sa perméabilité ;

LS, est un facteur sans dimension qui représente l’inclinaison (S) et la longueur de pente (L) ;

C, est un facteur sans dimension ; c’est l’occupation du sol ou l’indice de couverture végétale et de pratiques culturales ;

P, facteur sans dimension, est un rapport qui tient compte des techniques culturales antiérosives telles que le labour en
courbes de niveau.

Le prétraitement et le traitement des images ont été effectués avec Erdas imagine et ENVI, l'analyse, la combinaison de
toutes données et l’application du modèle ont été effectuées avec le logiciel ArcGis 10.0 (numérisation des cartes, l’analyse
spatiale, la combinaison des données, l’édition des cartes thématiques et la mise en place du SIG). La résolution de travail est
de 90m, et le système de projection appliqué à toutes nos données est Transverse Mercator zone 33, dont les principales
caractéristiques sont les suivantes : Ellipsoïde–Clarke 1884; Datum (système géodésique)–WGS_1984; False_Easting:
500000.000000; False_Northing: 0.000000; Central_Meridian: 9.000000; Scale_Factor: 0.999600; Latitude_Of_Origin:
0.000000; Linear Unit: Meter (1. 000000).

L’organigramme (figure 4) résume les différents traitements appliqués à nos données. La méthodologie utilisée est le
croisement (dans un SIG) des paramètres sous forme de combinaison logique avec pour finalité l’élaboration de la carte de
vulnérabilité multifactorielle à l'érosion hydrique des sols du bassin versant de Sanguéré.

3.2.1 LES DONNÉES PLUVIOMÉTRIQUES ET LE FACTEUR R

Le climat joue un rôle déterminant dans le risque d’érosion hydrique des sols, par le biais des précipitations (fréquence,
durée et intensité). L’estimation du facteur R selon la formule de Wischmeier et Smith est assez complexe. Selon [10], la
meilleure corrélation entre le facteur R et les valeurs de précipitation est celle basée sur l’Indice, (F), modifié de Fournier
(tableau 1). Pour notre étude, nous avons utilisé la formule linéaire de [15] qui améliore l’indice F de Fournier en tenant
compte des précipitations mensuelles allant d’avril à juillet et le total des précipitations  pour ces mois (tableau2).

Cette période a été choisie car après juillet, la végétation (cultures, savane arbustive...) est assez développée  dans le
bassin versant pour assurer une résistance avancée du sol à l’érosion.

R = 95,77 – 6,08F + 0,477F2 / 17,2 (2)
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Avec : = ∑
F : indice de Fournier ;

P : précipitations annuelles (total des précipitations);

pi : précipitations mensuelles

Les valeurs de R calculées (tableau 3) ont été interpolées en utilisant une méthode d’interpolation simple, l’IDW (Inverse
Distance Weight). En effet, les données espacées de plusieurs kilomètres ne présentent pas de précision suffisante pour
justifier une méthode d’interpolation spécifique.

Les valeurs de R obtenues après interpolation (IDW) et découpage par rapport au secteur d’étude (figure 5) varient de
506,64 à 528,09 MJ/mm/ha.H.an dans l’ensemble du bassin versant de Sanguéré ; avec une moyenne de 520,94 et un écart
type de 4,41.

3.2.2 LA CARTE PÉDOLOGIQUE ET LE FACTEUR K

Le facteur d’érodibilité exprime la vulnérabilité du sol à être érodé par la pluie. Il dépend de la granulométrie ou texture
du sol, de la teneur en carbone organique, de la stabilité structurale, de la porosité, de la perméabilité, etc.

Une équation de régression a été établie par [24] pour estimer la valeur de K :

K= ((2.1*10-4*(12-MO) *M1.14) + 3.25*(S-3) + 2.5*(P-2))/100 (3)

K, est le facteur d’érodibilité.

M, le facteur granulométrique,  = (% limon + % sable fin) (100 - % argile).

M.O (matière organique) en %.

S, le code de la texture du sol (granulaire très fine : 1; granulaire fine : 2; granulaire moyenne et grossière : 3; en block ou
massive : 4).

P, le code de la classe de perméabilité (rapide : 1; modéré à rapide : 2; modérée : 3; lente à modérée : 4; lente : 5; très
lente : 6).

Les paramètres physico-chimiques des sols utiles pour le calcul de K sont indiqués dans le tableau 4.

Les textures à dominance sableuse et la très forte perméabilité des matériaux ont orienté l’attribution des valeurs
indiquées dans le tableau 5 suivant pour les paramètres S (texture) et P (perméabilité).

Toutes ces données, introduites dans notre modèle RUSLE, ont permis de déterminer le facteur d’érodibilité K, suivant la
formule de [24] de l’équation (3) et d’attribuer sous SIG le facteur respectif à chaque type de sol.

Le facteur K a été déterminé, dans ArcMap, en introduisant au niveau du champ_K de la table attributaire de notre carte
des sols, la formule suivante (Field Calculator):

((2.1*power(10,-4)*(12- [MO_pourcent])*power(M,1.14)) + 3.25*([S]-3) + 2.5*([P]-2))/100

Avec : M= power((100 - [Argile_pourcent]),2)

En considérant que %Limon+%Sable+%Argile = 100, car les auteurs n’ont pas distingué les sables fins des sables grossiers.

Ce champ a été rastérisé (conversion Tools > to raster > Feature to raster) (figure 6).
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Le facteur K n’a pas pu être calculé au niveau des lithosols sur grès et des sols peu évolués d'apport hydromorphes sur
alluvions qui sont rencontrés respectivement sur des affleurements rocheux (inselberg) et au niveau des bas fonds
marécageux, et n’ont permis aucun échantillonnage de sol d’où la valeur 0 au niveau de ces unités.

Les valeurs obtenues pour le facteur K varient de 0,080 sur les sols peu évolués d'érosion lithosolique à 0,100 t.H/MJ.mm
sur sols lessivés tropicaux sur grès (tableau 6), avec une moyenne de 0,086 et un écart-type de 0,021.

Notre carte de répartition du facteur K épouse celle des sols du secteur d’étude.

3.2.3 L’IMAGE SRTM ET LE FACTEUR LS

La topographie du milieu est un facteur sensible pour l’érosion hydrique. La pente a une incidence importante sur le
processus d’érosion hydrique ; le ruissellement est généralement fort et rapide sur des pentes raides causant ainsi une
érosion hydrique très grave.

Le facteur topographique (LS) est calculé à partir de la longueur des pentes (L) et de leur inclinaison (S), déterminées à
partir de l’image SRTM 90 m.

Les longueurs d’écoulement correspondent théoriquement au rapport de la longueur λ (m), calculée entre le sommet du
versant et le début de la zone concave [16], à la longueur de la parcelle expérimentale de RUSLE (22,13 m) ; l’ensemble élevé
à l’exposant m, sans dimension, intégrant l’inclinaison de la pente β.

Le facteur L, en fonction de la surface drainage, se calcule selon la formule suivante [7] :

L = ((FA + CS2)m+1 – FAm+1) / Xm.CSm+2.(22,13)m (4)

Où :

FA (Flow accumulation), est l’accumulation du Flux.
CS (Cell size) est la taille du pixel.
X, un facteur de correction de la formule

L a été Déterminé dans Arcmap (Field Calculator):

(Power(("Flow_acc" + 8100),("m" + 1)) - Power("Flow_acc",("m" + 1))) / (Power(90,("m" + 2)) * Power(22.13,"m")).

Avec             F = (Sin β/0,0896) /(3.(Sinβ)0,8 + 0,56) ou

((Sin(("Pente") * (3.14 / 180))) / 0.0896) / (3 * Power(Sin(("Pente") * (3.14 / 180)),0.8) + 0.56).

et m = "F" / (1 + "F")

Ces deux paramètres calculés dans leur champ respectif dans la table attributaire de ce facteur, et les résultats intégrés
dans l’équation finale.

Le facteur S, quant à lui est estimé grâce à deux régressions simples appliquées en fonction de l’angle d’inclinaison, avec
la pente en degré :

S = 10,8sinβ + 0,03 si la tanβ < 0,09

S = 16,8sinβ + 0,5 si la tanβ ≥ 0,09 (5)

Sous ArcMap, il est obtenu à partir de la commande CON, qui est la fonction conditionnelle. Spatial Analyst Tools > Map
algebra >Raster Calculator:

Con(Tan(("Pente") * (3.14 / 180)) < 0.09,(10.8 * Sin(("Pente") * (3.14 / 180)) + 0.03),(16.8 * Sin(("Pente") * (3.14 / 180)) +
0.5)).
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La pente est convertie du radian au degré en multipliant par 3,14 et en divisant par 180.

Finalement le facteur LS est obtenu à partir du produit des facteurs L et S (figure 7), appliqué dans Spatial Analyst Tools >
Map algebra >Raster Calculator :

"L" * "S"

Les valeurs de LS varient entre 0,03 à près de 19, avec une moyenne de 0,55 et un écart-type de 0,91.

La carte de répartition du facteur topographique (LS), montre que les valeurs les plus fortes se trouvent logiquement au
niveau des altitudes les plus élevées de notre zone d’étude. Les zones de fortes pentes, correspondant aux zones de valeurs
élevées du facteur LS restent très minoritaires sur la zone d’étude, avec seulement 1,03 % des valeurs supérieures à 10.

3.2.4 LES OBSERVATIONS DE TERRAIN (L’OCCUPATION DES TERRES), L’IMAGE LANDSAT-8/LDCM ET LE FACTEUR C

L’occupation du sol ou facteur de protection du sol par la couverture végétale, exprime l’affectation du sol et son usage.
Ce paramètre peut influencer le risque d’érosion hydrique, en raison de son impact sur le ruissellement.

Le couvert végétal est considéré comme efficace contre l’érosion lorsqu’il absorbe l’énergie cinétique des gouttes de
pluies et protège les sols surtout dans la période de l’année où les précipitations sont les plus intenses.

Dans notre étude, ce facteur a été déterminé à partir de deux supports : nous nous sommes tout d’abord appuyés sur la
carte d’occupation du sol de notre secteur d’étude (figure 8, tableau 8, photo 1) dressée après une descente sur le terrain en
avril 2013, période de l’année où le couvert végétal est à son plus bas niveau dans la région, pour affecter un coefficient en
fonction du type d’occupation du sol observé (tableau 7) en nous référent aux travaux de [17] en Afrique de l’ouest et de [13]
à Madagascar.

Nous avons par la suite utilisé l’image Landsat-8/LDCM pour déterminer l’indice transformé de végétation ajusté pour le
sol, le MSAVI2 (Second Modified Soil-Adjusted Vegetation Index) de [14].

Le MSAVI2 (équation 6) développé à partir du MSAVI, en plus de ne plus nécessiter la détermination au préalable de la
valeur de la pente de la droite des sols, est utilisé pour un faible indice foliaire, Leaf Area Index (L.A.I.), ou un faible couvert
végétal ; ce qui est le cas dans notre secteur d'étude en cette période de l’année.

= ( ∗ ( ∗ ) ∗( ) )
(6)

Pour le calcul du MSAVI2 notre image a été transformée en valeurs de réflectances au sol par une calibration
radiométrique et une simulation de correction atmosphérique sur l’image.

La pratique d’un traitement radiométrique incluant une correction atmosphérique est indispensable ici, car l’on veut
accéder aux propriétés quantifiées (grandeurs physiques de l’image) des surfaces pour le calcul de l’indice de végétation.

La technique utilisée pour la calibration radiométrique est celle développée par [22] pour l’obtention du TOA (Top Of
Atmosphere reflectance) ou réflectance au-dessus de l’atmosphère, pour Landsat. Elle se résume comme suite:

 La conversion des valeurs numériques (DN, en anglais : Digital Number) en valeurs de réflectance au-dessus de
l’atmosphère (TOA) par détermination du paramètre Lλ' à partir de la relation :

Lλ' = ML * Qcal + Aρ           (7)

Où:

Lλ' = le TOA (Watts / (m2 * srad * um)) ; sans correction de l’angle du soleil.

ML = facteur multiplicatif de mise à l'échelle de la bande spécifique obtenu dans le fichier des métadonnées (.MTL) de
l’image (REFLECTANCE_MULT_BAND_x, où x est le numéro de la bande).

Aρ = facteur additif de rééchelonnement spécifique de chaque bande, obtenu dans le fichier des métadonnées (.MTL) de
l’image (REFLECTANCE_ADD_BAND_x), où x est le numéro de la bande).

Qcal = valeurs de  pixels standards quantifiés et calibrés (DN) ou encore l’image de la Bande_x.
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 Le calcul du TOA avec correction de l’angle solaire par application de la formule suivante :

Lλ = Lλ' / cosθs

Où

Lλ' = la réflectance au dessus de l’atmosphère ou le TOA

cosθs = cosinus du zénith solaire; zénith solaire = 90° - élévation solaire.

L’élévation solaire est obtenue à partir du fichier des métadonnées .MTL de notre image.

Cette étape a été calculée pour chaque bande de notre image à travers le module Band Math du logiciel ENVI 5.0.

 La simulation de correction atmosphérique par conversion des TOA en réflectance de surface s’est faite par la méthode
du Dark Object Subtraction (DOS).

L’application du DOS s’est faite automatiquement par le logiciel ENVI 5.0 à travers le module  Dark Subtraction.

La carte obtenue après affectation des coefficients à C a été rastérisée à partir de l’outil Conversion Tools > To Raster >
Polygone to Raster dans Arcmap, à une résolution de 90m et correspond à C1 ou facteur C1 (figure 11).

La détermination du MSAVI2 (figure 10) peut être faite soit dans Erdas Imagine à travers un Model Marker, soit
implémentée à partir de Spatial Analyst Tools > Map algebra >Raster Calculator, où l’on introduit la formule suivante :

(2*"B4"+1-(SquareRoot(Power((2*"B4"+1),2)-8*("B4"-"B3")))) / 2.

Avec B4, la réflectance dans la bande proche infra rouge (PIR) et B3, la réflectance dans la bande Rouge (R) de notre
image.

Ou encore implémentée dans ENVI à travers band math en introduisant :

float((2*(b1)+1-sqrt((2*(b1)+1)^2-8 * ((b1) - (b2))))/2)

Avec b1, la réflectance dans la bande proche infra rouge (PIR) et b2, la réflectance dans la bande Rouge (R) sont
sélectionnées à la demande.

Nous avons opté pour le Model Maker (figure 9) pour sa simplicité.

Le calcul du MSAVI2 a permis la détermination du facteur C2 (figure 12).

Le MSAVI2 est un indice non normalisé, les valeurs ne sont donc pas bornées. Les zones claires (blanches) de notre image
représentent un fort pourcentage de la végétation, les zones sombres un faible pourcentage de la végétation. Les valeurs
obtenues dans notre bassin versant varient entre 0,174 et 0,607 avec une moyenne de 0,296 et un écart type de 0,050.  Les
valeurs correspondant à la végétation sont celles supérieures à environ 0,300. L’image MSAVI2 laisse transparaitre de faibles
conditions de végétation dans notre secteur d’étude.

La valeur 1 du facteur C1 correspond à la valeur maximale en termes d’efficacité des processus érosifs. Les valeurs
obtenues pour C2 varient de 0,1820 à 0,598 avec une moyenne de 0,296 et un écart type de 0,050.

Le facteur occupation du sol obtenu à partir des observations sur le terrain (C1) présente des données circonscrites aux
coefficients introduits alors que ce même facteur obtenu à partir de l’image d’observation de la terre (C2) présente des
valeurs continues caractéristiques de la transition non franche entre les différents types du couvert végétal.

3.2.5 LES OBSERVATIONS DE TERRAIN (LA CARTE DE TECHNIQUES ANTIEROSIVES) ET LE FACTEUR P

Le facteur P exprime l’influence des méthodes de conservation sur l’érosion. Les cultures en courbes de niveau, en
bandes alternées ou en terrasses, les reboisements en banquettes, le buttage et le billonnage sont les pratiques les plus
efficaces de conservation des sols. Les valeurs de P sont inférieures ou égales à 1. La valeur 1 est attribuée aux terrains sur
lesquels aucune des pratiques citées n’est utilisée [19].

La population rurale de notre secteur d’étude a bénéficié de la part du projet Développement Paysannal et Gestion des
Terroirs (DPGT), du projet Eau Sol Arbre (ESA),  tous deux appuyés par les spécialistes de l’Institut de Recherche Agricole pour
le Développement (IRAD), des formations et encadrements pour la mise en place des techniques culturales et pratiques
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antiérosives (cordons pierreux, végétalisation par les graminées, des bandes antiérosives, les bourrelets au niveau des
courbes de niveau…). Ce facteur a été déterminé à partir des observations faites sur le terrain (figure 13, photos 2).

Les valeurs correspondant aux différentes pratiques antiérosives (tableau 9) ont été introduites dans le champ approprié.
Ce dernier a par la suite été rastérisé à 90 m de résolution à travers le module Conversion Tools > To Raster > Polygone to
Raster (figure 14).

Les valeurs obtenues pour ce facteur P varient de 0,01 pour les pailles à recouvrement de plus de 50% à 1 pour les zones
n’ayant aucune pratique antiérosive ; avec une moyenne de 0,417 et un écart-type de 0,349. La valeur 1, aucune pratique
observée, correspond aux affleurements (inselberg) et aux zones non cultivées essentiellement. Les pratiques antiérosives
sont bien développées dans la majorité de notre bassin versant avec une dominance de la technique du labour en isohypses
(tableau 10).

Les zones où sont pratiquées des labours en isohypses représentent plus de la moitié de notre secteur d’étude et
correspondent logiquement aux zones de cultures qui sont actuellement (en avril 2013) en chaume.

4 RÉSULTATS : ÉROSION HYDRIQUE, CERTES MODÉRÉE DANS LE BASSIN VERSANT MAIS, À TENIR COMPTE

SPATIALISATION DES PERTES EN SOL

Le croisement des différents facteurs utiles pour notre modèle s’est fait dans notre SIG (ArcGis) où nous avons introduit le
produit de ces différents paramètres obtenus (R, K, LS, C et P) à travers l’option Spatial Analyst Tools > Map algebra >Raster
Calculator :

"R" * "K" * "LS" *  "Cx" * " P"

Le résultat obtenu, qui correspond aux zones de notre bassin versant exposées à l’érosion hydrique des sols, constitue le
paramètre A de notre modèle RUSLE.

Les résultats de la spatialisation du risque d’érosion hydrique sont proposés sous deux formes.

La première forme (figure 15, a et b) présente le phénomène en continue; ce qui fournit un aperçu rapide de la situation
dans la zone d’étude.

Chaque unité possède les valeurs homogènes des cinq facteurs du RUSLE.

La seconde forme (figure 16, a et b) présente la spatialisation du risque répartie en six classes (tableau 11 et tableau 12),
pour C1 et C2 respectivement. Cette classification permet une représentation plus détaillée et, par là, une bonne
identification des causes de risques dans le bassin versant.

Une analyse des données indique que les valeurs obtenues présentent un risque d’érosion variant dans notre zone
d’étude et surtout une structure spatiale définie par la localisation topo-paysagère. Les secteurs où l’érosion n’a pu être
déterminée (classe 1) correspondent aux zones où le facteur K n’a pu être calculé c’est-à-dire les affleurements rocheux
(inselberg) et les bas fonds marécageux, qui n’ont permis aucun échantillonnage de sol.  Les zones présentant les plus hauts
niveaux de risque d'érosion sont localisées au niveau des sols sous savane sèche et de certaines pentes de collines et celles
présentant le risque d’érosion modérée se trouvent, majoritairement, au niveau des chaumes. Si l’on considère qu’à partir de
la classe d’érosion modérée le risque est important, notre bassin versant présenterait pour la première carte à risque (C1)
une superficie d’environ 51,72 Km² exposée à l’érosion hydrique, soit 62,46 % de sa superficie totale ; et pour la seconde
carte à risque (C2) une superficie d’environ 61,40 Km² exposée à l’érosion hydrique, soit 74,60 % de sa superficie totale

UNE ÉROSION HYDRIQUE DES SOLS, CERTES MODÉRÉE DANS LE BASSIN VERSANT MAIS, À EN TENIR COMPTE

Pour faciliter la comparaison des deux résultats obtenus, une avons effectué une superposition des valeurs de
pourcentage de la surface des classes d’érosion de ces deux résultats (figure 17, tableau 13).

L’observation des résultats issus de la comparaison entre ces deux résultats (C1 et C2) présente globalement des
différences peu significatives. En effet, l’écart entre les deux résultats ne dépasse que ponctuellement les 2%, les écarts les
plus importants étant un peu plus de 10%. Ce résultat est logiquement expliqué par le fait que la couche facteur C qui joue un
rôle important dans les processus d’érosion n’est pas la même pour C1 (coefficients affectés) et C2 (interprétation du
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MSAVI2). La précision des thèmes d’occupation du sol, notamment des sols nus et des zones boisées ont agit directement sur
le résultat de C1.

Par rapport aux observations faites sur le terrain et à l’interprétation visuelle des images Landsat 8 et google earth de la
zone, la spatialisation du risque d’érosion obtenue avec la couche MSAVI2 nous semble présenter le mieux le risque dans le
bassin versant de Sanguéré. Toutefois, nous notons une similitude entre  les deux résultats de spatialisation du risque
d’érosion avec une forte corrélation de plus de 80% (figure 18).

5 DISCUSSIONS

L’application du modèle RUSLE apporte une information intéressante sur le risque dans le bassin versant de Sanguéré. Il
convient cependant de discuter les résultats présentés dans cette étude au vue de l’échelle d’analyse, des paramètres du
modèle par rapport aux données (disponibles) utilisées et du choix de l’équation.

Les données utilisées dans le cadre de notre travail sont issues de bases de données globales (SRTM, USGS), des
structures régionales publiques (Station météorologique de Garoua), privées (SODECOTON), des observations de terrain ou
encore produites à partir d’anciennes cartes (carte pédologique). L’échelle de production des facteurs de l’équation est donc
différente ; une maille de 90 m a donc été choisie.

L’échelle d’analyse qui est ici celle d’un bassin versant de quelques km² correspond à celle de la modélisation initiale
proposée par [24] qui porte sur de petites parcelles (100 m²) ou de petits bassins versants de quelques hectares.

Le facteur R a été calculé à partir de l’équation de régression proposée par [15] qui améliore l’indice F de Fournier en
tenant compte des précipitations mensuelles et la moyenne annuelle des précipitations (dans notre cas, le total des
précipitations sur les mois considérés). Il a été calculé à partir des données fournies par le Service d’Appui Technique de la
SODECOTON complétées par celle de la station météorologique de Garoua, toutes couvrant notre site. Le nombre insuffisant
des stations de relevées pluviométriques dans la région, la qualité des instruments existant et les erreurs de relevés dus aux
opérateurs poseraient le problème quant à la précision de ce facteur. Les résultats obtenus, semblables à ceux obtenus par
Roose (1977) en Afrique de l’Ouest et du centre  sont satisfaisants pour cette étude.

Le calcul du facteur K a été produit par application de la formule proposée par [24] sur les données issues de l’analyse de
la carte pédologique détaillée du bassin versant de Sanguéré, dressée par [4]. Les valeurs moyennes des paramètres physico-
chimiques des 20 premiers centimètres des sols ont été utilisées. Cette approche a permis d’estimer l’érodibilité des sols en
fonction de leurs textures. Il faut tout de même noter que ce facteur varie dans le temps et dans l’espace en fonction des
propriétés dynamiques du sol, de la pente, de l’occupation du sol et des techniques culturales [18]. Dans notre étude, les
valeurs de K ont été attribuées en exploitant la notice explicative de la carte des sols. Mais, les données sur la pédologie, bien
que détaillées de notre bassin versant, ne sont plus représentatives des conditions actuelles. La carte pédologique date des
années 1970-1980 (comme toutes les autres cartes pédologiques de la région) et mérite d’être mise à jour. Les propriétés
physiques et chimiques (texture, structure, matière organique, perméabilité…) pour les horizons superficiels ont pu changer
dans le temps du fait de la rotation culturale annuelle et l’intense activité agricole dans le bassin versant. Une fois les sols
dénudés, leur modification est favorisée par l’agressivité du climat et leur fragilité naturelle, ce qui entraîne l’accélération des
pertes de sols. Il serait donc intéressant de disposer de données mises à jour sur la granulométrie en fonction des différents
types d’occupation du sol et sur la matière organique.

Pour le calcul du facteur LS, tous les traitements permettant d’aboutir au calcul de ce facteur ont été réalisés à partir du
SRTM à 90 m de résolution spatiale, ceci pose alors la question de la précision de la donnée produite en sortie.

Cependant selon différents travaux [11] - [6], le SRTM apporte une description plus fidèle de la topographie par rapport à
d’autres types de données telles que les données ASTER DEM à 30 m de résolution. En effet, ces données à plus haute
résolution spatiale sont produites à partir d’images optiques par stéréoscopie [8] - [12] et offrent une représentation moins
réaliste de la topographie. Les calculs de pentes qui en découlent montrent une tendance à la surestimation des zones planes
à modérément planes".

L’équation utilisée pour le calcul du facteur LS montre des résultats satisfaisants par rapport à la topographie réelle du
bassin versant, dont la pente est en moyenne inférieure à 5 % et la longueur de pente maximale estimée à 263 m.

Pour le facteur C, il s’est tout d’abord posé le problème d’affectation des coefficients à ce facteur. En effet, il a été difficile
pour nous de distinguer la nature exacte de l’occupation du sol ou encore le taux exact de recouvrement du sol, à cause de la
période d’observation, ce qui poserait le problème quant à sa précision. Néanmoins, nous nous sommes appuyés sur d’autres
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travaux ([17] en Afrique de l’ouest et [13] à Madagascar) pour affecter les coefficients à ce facteur en fonction du type
d’occupation du sol. Par la suite nous avons utilisé l’image Landsat8 pour déterminer l’indice de végétation MSAVI2 ; les
résultats obtenus pour les deux cas sont très proches quand à la spatialisation du phénomène, satisfaisantes et reflètent,
presque, la réalité sur le terrain.

Le facteur P est essentiellement issu des d’observations faites sur terrain, c’est le seul facteur qui reflète  parfaitement la
réalité de terrain.

Aujourd’hui, beaucoup d’équations existent dans la littérature pour la détermination des pertes en sol. Le modèle le plus
rencontré, le RUSLE a souvent été utilisé hors de son contexte d’application ; les équations dérivées permettent de le
déployer dans des régions climatiques et géologiques différentes ainsi qu’aux pays peu renseignés dont les données sont peu
disponibles ou inexistantes (les pays en voie de développement, intertropicaux, méditerranéens...). Dans ces milieux, le
besoin d’information sur les processus érosifs à échelle régionale est important au vue de la dégradation actuelle sur les
bassins versants.

Le RUSLE est un modèle empirique par conséquent son application à une zone d’étude donnée peut être à l’origine de
biais ou d’erreurs dans l’évaluation des facteurs de cet équation et donc dans celle des pertes de sol. Cependant, son
intégration dans un SIG présente beaucoup d’avantages, surtout ceux liés au grand nombre de résultats relatifs aux facteurs
impliqués dans l’érosion hydrique :

 gestion de façon rationnelle, d’une multitude de données qualitatives et quantitatives relatives aux différents facteurs de
l’érosion ;

 production d’une carte synthétique de répartition des degrés de sensibilité à l’érosion des différentes zones du bassin
versant. Cette cartographie est un outil pour la gestion de l’érosion. Les décideurs locaux peuvent cibler leurs actions et
simuler les scénarios d’évolution.

6 ESSAI DE VALIDATION DU MODÈLE

Une validation rigoureuse de notre modèle et les cartes produites nécessite la mise en correspondance de nos cartes à
risque (sur quelques zones représentatives) avec des observations sur le terrain. Cependant, faute de pouvoir retourner sur
le terrain pour cette étape de validation, nous avons comparé directement les résultats issus de notre étude à des données
sur l’érosion hydrique acquises par d’autres voies.

Très peu de mesures sur l’érosion dans le nord existent. Les rares données concernent des mesures in situ sur quelques
bassins versants représentatifs [23] et sur des parcelles d'érosion (57 parcelles) de 100 à 1080 m2 [3] effectuées dans le Nord
Cameroun (Sanguéré-Djalingo et Mbissiri, respectivement). Ces études ont essentiellement quantifié les pertes en terre ; il
est donc difficile de faire une comparaison directe entre ces valeurs mesurées et notre carte spatialisant le risque.
Cependant, les valeurs obtenues  0.5 à 35 t/ha/an à Sanguéré-Djalingo ; 05 à 35 t/ha/an (sur le système de culture
conventionnel), 0.2 à 03 t/ha/an (sur le système conservateur), 03 à 05 t/ha/an (sur le labour paillé) à Mbissiri  (un village
situé au sud-est de Garoua) sont d’un ordre de grandeur pouvant correspondre aux classes de risque érosif spatialisé dans
notre secteur. Les résultats fournis par ces méthodes différentes semblent cohérents.

Au-delà des difficultés de validation, et malgré le fait que la carte du risque d’érosion hydrique présente uniquement les
secteurs à risque de détachement des sédiments, les zones de dépôt n’apparaissant pas, nous pensons que la répartition
spatiale proposée reflète toutefois la réalité dans le bassin versant, productif, de Sanguéré.

En définitive, on ne peut donc pas considérer que le modèle soit strictement validé à ce stade du travail. Un programme
de suivi sur plusieurs années est envisagé dans le site et dans d’autres bassins versant exposés au risque d’érosion hydrique.
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7 TABLEAUX, FIGURES ET PHOTOS

7.1 TABLEAUX

Tableau 1. Calculs approximatifs de R (Eltaif et al., 2010)

Auteurs R
Arnoldus (1977) – exponentiel R = 0,03*F1,9         pour les USA et l’Afrique
Arnoldus (1980) - linéaire R = (4,17*F-152)/17,2
Renard et Freimund (1993) R = 0,07397*F1,847/17.2       quand  F<55mm
Renard et Freimund (1993) R = 95,77 - 6,08F + 0,477F2/17.2   quand  F>=55mm
Yu et Rosewell (1996) R = 3,82*F1,41

Tableau 2. Précipitations moyennes mensuelles (mm), totales (mm) pour la période 1998-2011

X (m) Y (m) Stations avril mai juin juillet Total
322449 1032111 Garoua 38,35 95,5 163,79 177,42 475,06
353299 1001537 Lagdo 18,85 75,86 167,71 186,07 448,49
336429 997764 Ngong 19,71 82,43 141,43 163,14 406,71

Tableau 3. Valeurs moyennes de R calculées

Stations Total_P  (mm) F R (MJ/mm / ha. H. an)
Garoua 475,06 145,023 537,58
Lagdo 448,49 153,54 605,06
Ngong 406,71 132,28 444,08

Tableau 4. Propriétés physiques (sur 20 cm) des sols étudiés

Type de sols Argile (%) Limon (%) Sable (%) M.O(%) Texture
Lithosols sur grès - - - - -
Sols peu évolués d'apport hydromorphes sur alluvions - - - - -
Sols peu évolués d'érosion lithosolique 13,1 8,8 78,1 0,8 Sableux
Sols ferrugineux Tropicaux lessivés 13,2 6,8 80 0,6 Limono-sableux
Sols Ferrugineux Tropicaux Beiges 6,6 11 82,4 0,82 Sablo-limoneux
Sols Ferrugineux Tropicaux Rouges 6,6 11 82,4 0,82 Sablo-limoneux
Sols peu évolués d'apport sur colluvions 9,9 7,3 87,8 0,6 Sablo-limoneux
Sols hydromorphes minéraux à gley de surface sur grès 5,25 12,5 82,25 0,7 Sablo-limoneux
Sols lessivés Tropicaux sur grès 5,4 11 83,6 0,5 Sablo-limoneux
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Tableau 5. Valeurs de S et P des sols étudiés

Type de sols Texture S Perméabilité P
Lithosols sur grès Sableux 3 Perméable 2
Sols peu évolués d'apport hydromorphes sur alluvions Limono-sableux 3 Perméable 2
Sols peu évolués d'érosion lithosolique Sablo-limoneux 3 Perméable 2
Sols ferrugineux Tropicaux lessivés Sablo-limoneux 3 Perméable 2
Sols Ferrugineux Tropicaux Beiges Sablo-limoneux 3 Très perméable 1
Sols Ferrugineux Tropicaux Rouges Sablo-limoneux 3 Très perméable 1
Sols peu évolués d'apport sur colluvions Sablo-limoneux 3 Perméable 2
Sols hydromorphes minéraux à gley de surface sur grès Sableux 3 Perméable 2
Sols lessivés Tropicaux sur grès Limono-sableux 3 Perméable 2

Tableau 6. Valeurs de S et P des sols étudiés

Facteur K Surface (Km²) Pourcentage
0,100 4,587 5,63
0,099 3,991 4,9
0,095 41,847 51,33
0,094 01,274 1,56
0,082 10,963 13,45
0,080 14,650 17,97
0 4,211 5,16

Tableau 7. Facteur C en fonction du type d’occupation du sol

Type d’occupation du sol Facteur C
Champs et Plantations (vert) 0,01
Chaume 0,02
Inselberg 0,9
Savanes et arbustes sur colline de pierre 0,2
Savanes herbacées (verte) 0,01
Savanes sèches, quelques pieds d'arbustes 0,4
Sol nu 1
Villages 0,15
Zones boisées 0,001

Tableau 8. Répartition de l’occupation du sol dans le secteur d’étude

Occupation du sol Surface (Km²) (%)
Champs et Plantations (vert) 0,047 0,06
Chaume 55,069 67,33
Inselberg 6,972 8,52
Savanes et arbustes sur colline de pierre 0,259 0,32
Savanes herbacées (verte) 0,201 0,25
Savanes sèches, quelques pieds d'arbustes 7,004 8,56
Sol nu 0,992 1,21
Villages 3,001 3,68
Zones boisées 8,236 10,07
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Tableau 9. Catégorisation du facteur P

Techniques Code
Aucune pratique 1
Labour isohypse 0,5
Paille à recouvrement de 50% 0,2
Prairie, plantes de couverture 0,1
Murette de pierre 0,01

Tableau 10. Répartition du facteur P dans le bassin versant de Sanguéré

P Nature Surface (Km²) Pourcentage
0,01 Paille à recouvrement de 50% 0,008 0,010
0,1 Murette en pierre 1,478 1,807
0,2 Labour isohypse 55,069 67,333
0,5 Prairie, plantes de couvertute 4,415 5,399
1 Aucune pratique 20,816 25,451

Tableau 11. Classes d’érosion et répartition dans le bassin de Sanguéré pour C1

Classe Erosion des sols Surface (Km²) Pourcentage (%)
1 Non déterminée 03,93 04,75
2 Nulle à Très Faible 11,18 13,51
3 Faible 15,96 19,28
4 Modérée 28,54 34,48
5 Elevée 15,25 18,41
6 Grave 07,92 09,57

Tableau 12. Classes d’érosion et répartition dans le bassin de Sanguéré pour C2

Classe Erosion des sols Surface (Km²) Pourcentage (%)
1 Non déterminée 03,9 04,73
2 Nulle à Très Faible 09,9 12,03
3 Faible 07,11 08,64
4 Modérée 37,1 45,07
5 Elevée 17,52 21,29
6 Grave 06,78 08,24

Tableau 13. Comparaison entre les surfaces (%) des résultats de C1 et C2

classes Erosion des sols C1 C2 C1 –C2
1 Non déterminée 4,75 4,73 0,02
2 Nulle à Très Faible 13,51 12,03 1,48
3 Faible 19,28 8,64 10,64
4 Modérée 34,48 45,07 -10,59
5 Elevé 18,41 21,29 -2,88
6 Grave 9,57 8,24 1,33
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7.2 FIGURES

Fig. 1. Localisation du bassin versant de Sanguéré

Fig. 2. Oro-hydrographie de la zone d’étude
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Fig. 3. Carte des sols du bassin versant de Sanguéré (Brabant et Fardin, 1979).
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Fig. 4. Organigramme de la méthode suivie dans cette étude
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Fig. 5. Distribution des valeurs du  facteur R



S. C. Nguemhe Fils, J. Etouna, and M. Hakdaoui

ISSN : 2028-9324 Vol. 9 No. 1, Nov. 2014 467

Fig. 6. Le facteur d’Erodibilité (Facteur K)



Apport de l’OT et du SIG à la cartographie des zones à risque d’érosion hydrique dans le bassin versant productif de
Sanguéré,  Nord-Cameroun, Afrique Centrale

ISSN : 2028-9324 Vol. 9 No. 1, Nov. 2014 468

Fig. 7. Le facteur topographique (Facteur LS)
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Fig. 8. L’occupation du sol dans le bassin versant de Sanguéré

Fig. 9. Model Maker pour le calcul du MSAVI2

((2 * $n1_PROMPT_USER($n4_Integer))  + 1 -
( SQRT (  (((2 * $n1_PROMPT_USER($n4_Integer))
+ 1)**2) - (8*($n1_PROMPT_USER($n4_Integer) -
$n1_PROMPT_USER($n5_Integer))) ) )) / 2
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Fig. 10. L’image MSAVI2 dans le secteur d’étude
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Fig. 11. Le facteur C1
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Fig. 12. Le facteur   C2
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Fig. 13. Les pratiques antiérosives dans le secteur d’étude
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Fig. 14. Le facteur pratiques antiérosives
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Fig. 15. Répartition spatiale en continue de l’érosion des sols dans le bassin versant de Sanguéré.
a) en fonction de C1 ; b) en fonction de C2

Fig. 16. Répartition spatiale en classe de l’érosion des sols dans le bassin versant de Sanguéré.
a) en fonction de C1 ; b) en fonction de C2
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Fig. 17. Les écarts entre les résultats C1 et C2

Fig. 18. La corrélation entre C1 et C2
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7.3 PHOTOS

Photo 1 : L’occupation des terres du bassin versant de Sanguéré (Avril, 2013). (Photos : Nguemhe Fils)

Champs de Jatropha de l’IRAD

Champs et plantations

Chaumes

Inselberg

Savane arbustive verte

Savane arbustive sur colline de pierre

Savane sèche

Verger d’anacardier (zone boisée)
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Photo 2 : Les pratiques antiérosives dans le bassin versant de Sanguéré (Avril, 2013). (Photos: Nguemhe Fils)

8 CONCLUSION GÉNÉRALE

Le présent travail avait pour objectifs d’apprécier l’apport de l’OT et des SIG à la spatialisation de l’érosion hydrique et de
montrer l’application d’un modèle largement diffusé, le modèle RUSLE, à la mise en évidence des zones les plus sensibles à
l’érosion dans le bassin versant de Sanguéré, au Nord Cameroun. Il apparait à l’issue de notre étude que l’érosion hydrique
est omniprésente dans le bassin versant. Le risque dans tout ce secteur couvre une surface de plus de 50 Km² sur les près de
82 Km² de toute la zone, soit plus de 60 % de sa superficie totale exposée à l’érosion hydrique. Ces résultats doivent faire
l’objet de beaucoup d’attentions de la part des décideurs. En effet, le phénomène d’érosion hydrique prend une ampleur
considérable dans les zones soudano-sahéliennes et sahéliennes du grand Nord-Cameroun (une région les enjeux agricoles et
environnementaux sont élevés) avec pour conséquences la dégradation des terres, les pertes de productions, etc.

Le RUSLE, s’est avéré être un modèle simple et pratique dans notre contexte. Malgré l’hétérogénéité des données une
modélisation de l’érosion hydrique a pu être menée à l’échelle du bassin versant.  Cette méthode de cartographie du risque
érosif peut facilement être adaptée à l’ensemble de la Région du Nord, apportant une aide importante aux agriculteurs et
aux décideurs pour l’identification des zones nécessitant la plus grande priorité d’intervention préventives pour la protection
du patrimoine sol. Ce travail a également aidé à constituer une base de données multisources de la zone d’étude à l'aide du
SIG, ce qui facilitera la vulgarisation, le suivi et la mise à jour des données et résultats.

En perspectives, il serait utile d’apporter une meilleure description des facteurs C, K et LS afin, en plus de spatialiser le
risque, d’estimer une quantification des pertes de sols. Une expression des pertes en sols en relation directe avec la
productivité des cultures serait d’un apport certains pour les populations rurales de cette région. Il est également
envisageable d’effectuer une cartographie des zones à risque d’érosion hydrique liées aux inondations en tenant compte des
changements climatiques.
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Murette en pierre
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